
KayakFoundry Change History 
Date Version Description 
November 14, 2009 1.6.4 • Fixed export of station forms.  The Y values were all shifted by an offset related to the 

position of the moveable DWL. 
October 23, 2009 1.6.3 • Fixed sheer height value displayed in the Active Section area of the hydrostatic panel. 
October 20, 2008 1.6.2 • Extend stability curves to 180 degrees.  Use a single worker thread to compute all stability 

thread data.  Only compute data for curves that are enabled for display. 
September 11, 2008 1.6.0 • Stability Curves! 
October 20, 2007 1.5.6 • Manually introduced shaping sections did not fully contribute to hydrostatic calculations.  

The effect was most exaggerated when the new shaping section had very different shape 
characteristics than the other standard shaping sections.  Fixed. 

July 12, 2007 1.5.5 • Fixed a bug in the computation of the wetted surface area that became evident only on 
designs where the DWL was significantly far from the zero baseline. 

• Fixed a bug in the drawing of the waterlines in the Plan View that was evident only on 
designs where the DWL was significantly far from the zero baseline. 

April 22, 2007 1.5.4 • Added baseline to active section panel with centerline intersection line. 
• Fixed Print dialog custom scaling was not enabling the edit field.  

February 11, 2007 1.5.3 • Fixed bug where changing the paddler weight in preferences would prevent you from being 
able to start a new design. 

December 12, 2006 1.5.2 • Fixed bug where some forms were printed without the inner form boundary. 
October 23, 2006 1.5.1 • Fixed bug where changing the paddler weight in a multi-cockpit design did not immediately 

re-calculate the cumulative CG. 
July 16, 2006 1.5 • Fixed bug where adding a cockpit did not enable the cockpit control points in the profile 

view. 
• Fixed a crash (divide by zero) when the deck control point would approach the sheerline. 
• Fixed the launching of .yak files to handle paths that contain blanks. 
• User now has full control over hull cross-section control points.  The program no longer 

assists in defining the hull cross-section shape.  The hull and deck control points have full 
range of motion, allowing you to create a flared hull 

• The design waterline (DWL) can be raised and lowered to control the design displacement. 
• Forms can be arranged on a virtual canvas.  Forms are printed according to their 

placement on the canvas. 
• Integrated KAPER drag prediction. 
• The volume distribution curve is now derived from the hull shape.  It cannot be directly 

manipulated. 
• The design file format has changed.  Designs from earlier versions are converted to the 

new format automatically. 
• Sinkage added to hydrostatics.  Indicates the weight required to sink the hull an additional 

inch. 
• Added access to the KayakFoundry website and forum from the Help menu. 
• Added read-only mode to help protect designs from accidental changes. 
• Added sheerline to body plan view. 

February 22, 2005 1.03 • Some designs would show a difference between actual and target volume.  The 
computation for cross section was giving-up too soon, not making the hull curvature full 
enough to achieve the correct area. 

June 15, 2004 1.02 • Debug mode is now off by default. (It had incorrectly been enabled by default in 1.01) 
• Opening the preferences dialog and then canceling was causing a program crash later. 

September 19, 2003 1.01 • Added the centerline to the printed cockpit form. 
• Scaling-down displacement of multi-cockpit designs now functions properly. (It was setting 

paddler weights to 0) 
• Rubber-banding to select multiple control points (left-click and drag).  This feature was 

accidentally disabled sometime prior to v1.0. 
April 1, 2003 1.0 • Added File menu function to export the design as a graphic.  The layout is similar to a 

study drawing, but in color.  Currently, the only output format is PNG.  
• Added Preferences under the Options menu.  The Preferences dialog allows you to specify 

a number of initial design parameters and the preferred display characteristics. 
• Main window size and position is remembered from session to session. 
• Added optional background grid with snap-to-grid functionality.  Grid can be displayed as a 

point or crosshatch pattern.  User-specified grid interval. 
• Added File menu function to Export Forms.  This generates a text file with coordinates that 

represent the shape of each form. 
• Added drag-n-drop for opening .yak files. 
• Added optional waterline and baseline to profile and section views in the study drawing. 
• Increased threshold for minimum computed underwater volume from 2.5 cm² to 10 cm².  

The sections with underwater areas that are less than the threshold are shaped to mimic 
the next larger section.  This is done to maintain smooth transitions from section-to-section 
at the bow and stern.  The support for minimum keel width required an increase in this 
threshold. 

• The contact info hyperlink in the About box will now works (assuming an internet 
connection is available). 

• Associated an icon with the executable KayakFoundry program. 
• Modified Scale dialog to be more flexible.  Allows you to specify a specific dimension value 

rather than a scaling factor. 



• Modified Print-Forms dialog to allow you to change the margins used on each printed page. 
• Modified parsing of dimension entry strings to allow input like “1ft 2in.”. 
• Removed separate “Print Active Section” button from Print Forms dialog and replaced with 

a checkbox that follows the active section line. 
• The rectangle representing the water was incorrectly drawn with a border in profile and 

active section views when in low-detail level. 
• Moving the plan view’s 2nd bow control point perpendicular to the tip of the bow caused 

anomalous buttock lines and sometimes resulted in a crash. 
• Possible divide-by-zero crash when moving linked control points into vertical alignment. 



November 16, 2002 1.0 Beta 5 • Added support for minimum keel width.  This allows you to avoid a knife-edge keel at the 
stems which is undesirable (and virtually unattainable) in a strip kayak.  The on-screen 
forms will be drawn with a flat keel line of this width as will the outer surface shown on the 
printed forms.  Of course, when building the design the edges should be rounded over.  A 
good starting point is a width that is roughly twice the thickness of the strips that will be 
used during construction. 

• Added status bar indicators to show design name, filename, and saved state. 
• Added Total Volume to the Capacities item in the Hydrostatics panel.  Added target/actual 

volume of water needed to achieve the Design Displacement. 
• Added accelerator keys for some menu items. 
• Used finer internal precision when computing underwater area of forms. 
• Changed “Deck Adjustments” to “Shape Constraints”.  Added the minimum keel width 

setting here. 
• Improved the algorithm for generating the form outline on the printed station forms. This 

results in a smoother form outline for those cross sections that have a sharp transition 
between deck and hull at the sheer. 

• Changing the position of the active section slider no longer marks the design as modified. 
• In the Hydrostatics panel, changed “Total Displacement” to “Design Displacement”. 
• In the Hydrostatics panel, changed “Positions” to “Centroids”. 
• Fixed: Setting the Exaggerate level from the right-click popup did not update the view until 

the view was resized.  Using Control-<plus>/<minus> worked correctly. 
• Fixed: Calculating cross sectional shape could differ slightly depending on the direction the 

program approached the final control point position.  Changed this to consistently choose 
the set of control points that provide the closest match to the required area, which could be 
slightly over or slightly under the required area. 

 
October 24, 2002 1.0 Beta 4 • The waterline position in Profile, Body Plan, and Active Section panels can be shifted up or 

down to optimize the viewable area.  The mouse cursor changes to a pointing finger when 
hovered over the waterline (even if the waterline is obscured).  Click and drag to desired 
position. 

• After setting a panel to Full Screen, the previous panel layout can be restored by clicking 
View/Restore-Last-Layout or hitting the <ESC> key.  The Full Screen panel then can be 
restored by clicking View/Last-Full-Screen or hitting the <ESC> key. 

• Moving a control point that changes the LOA (in Plan or Profile), causes the image scaling 
to be recalculated to ensure that the entire kayak fits into the viewable area.  In earlier 
versions, this was done instantaneously and made it difficult to judge how much the control 
point was being moved.  Now there is a slight delay between when the user stops moving 
the control points and when the scale is recalculated.  This results in an image shift a 
moment after the user’s completed the length changes.  

• Changed “Keel Depth” to “Draft” in Active Section info. 
• Added LCB marker to Profile panel. 
• Reworked the Zoom and Exaggerate functionality to optimize the size of the viewable area.  

Also added the ability to scroll the view in Exaggerate mode. 
• Printed stem forms now contain the projected sheerline to aid in aligning station forms. 
• Modified station form printing to include optional outer dimensions and optional horizontal 

and/or vertical reference marks at a user-specified interval. 
• Removed accelerator keys for add/remove cockpit. 
• Added ability to select hydrostatic data and copy to the clipboard.  Control-C copies the 

selected data.  Control-A selects all data.  Clipboard data can be pasted into a word 
processor for printing. 

• The parallel inner curve of printed station forms may not be drawn for small forms with 
highly-peaked decks.  

October 14, 2002 1.0 Beta 3a • Yet another floating point rounding error sometimes caused the control points of the 
shaping sections to be inaccessible and for the prev/next controls to stop working. 

October 14, 2002 1.0 Beta 3 • Double-click in Plan, Profile and Distribution of Volume panels will move the active section 
to the mouse position. 

• Double-click on a cross-section in the Body Plan panel to make it the active section. 
• Added the contents of the Notes panel to the study drawings.  In order to fit as much text 

as possible into the space, all linefeeds are removed. 
• Prevented the last open panel from being hidden. 
• In the Print Forms dialog, changed Done to Close. 
• Updates to the manual 
• Added wait-cursor when creating a new design or opening an existing design. 
• Added beta number to AboutBox. 
• Increased some line widths on printed forms. 
• Changed minimum form scaling from 1/10 to 1/12. 
• Added rocker value to Active Section in Hydrostatics panel. 
• Added What’s This text for items in the hydrostatics panel.  
• Added What’s This item to right-click popup menus for each panel. 
• Increase keyboard scroll amount as zoom level increases. 
• Modified the pointer for the sliding active section line.  It now functions in the same way as 

other control points.  It is hidden when the panel loses focus, and it can be selected and 
moved by the arrow keys as well by mouse. 

• Added “Adjust Displacement” to the Edit/Scale dialog.  When checked, the displacement 
will be adjusted appropriately to maintain a similar cross-sectional shape. 

• The scaling operation now supports undo/redo. 



• Fixed: Shorter kayaks were not longitudinally centered in the Plan and Profile panels. 
• Fixed: Study plan header text for “Bow” could be truncated on high-resolution printers. 
• Fixed: Body Plan did not print correctly in study drawings on some printers. 
• Fixed: Use of certain characters within the Design Name and Designer fields would cause 

parsing errors when the file was subsequently opened. 
• Fixed: Discrepancy in display of half-angles. 
• Fixed: Scaling function was scaling the BOA dimension twice and the sheer height and 

cockpit heights not at all. 



October 7, 2002 1.0 Beta 2 • Added “Full Screen” option to right-click popup menu.  This hides all panels but the one 
with focus. 

• Added a Notes panel to allow the user to add a text description of the kayak design. 
• Added entries in the data panel for Design Name and Designer. 
• Added Exaggerate option to right-click popup menu in Plan and Profile panels. Also, the 

Control-plus/minus keys increment/decrement to the next level. Allows the height to be 
scaled-up by 2, 3, 4, or 5 times to aid in creating smooth curves. 

• Added more info to the “unsaved changes” warning dialog. 
• Added display of control point path in Active Section view.  This shows the line that the 

internally-generated hull control point will lie upon for representative shaping sections. 
• Completed printed study plans (at least for now).  Added outline of deck and profile views 

for sketching strip patterns. 
• Zooming scales the thickness of the cockpit lip. 
• Better resolution on printed stem forms.  Added form numbers to alignment marks. 
• Allow numeric input fields to accept “0” without requiring specified units. 
• Used magnitude-based precision when displaying decimal values in imperial units. 
• Modified Print Forms dialog.  Introduced a separate form scaling setting.  Printed forms 

indicate the form scaling factor, and the printed dimensions and distances are adjusted 
accordingly.  The strip thickness setting is honored regardless of form scaling factor. 

• Increased maximum zoom to 400%. 
• Fixed: Incrementing the zoom level using the “+” key would allow the zoom level to go one 

increment past the previous max of 300%. 
• Fixed: Expanding/collapsing/editing entries in the hydrostatics panel caused unexpected 

focus changes. 
• Fixed: About Box was not modal.  In addition to keypress dismissal, added mouse-click 

dismissal.  
• Fixed: Opening the same file multiple times resulted in multiple design windows.  Now, that 

sequence will popup a brief notification and then set focus to the original design window. 
• Fixed: Edit/CopyDragStatsToClipboard was enabled even with no active designs. 
• Fixed: The buttock curves in study drawings were not closed curves. 
• Fixed: Stem form length could be longer than specified due to rounding errors. 
• Fixed: Some Imperial dimensions could be displayed as n’ 12”  
• Fixed: The outer curve of the cross-sections on the study plans was “spotty” due to clipping 

boundary being too close. 

Known Bugs and Limitations: 

• Recurve at the stern is not handled very well.  The program calculates LOA based on the 
distance between control points at the tip of the bow and stern.  This will be inaccurate if 
the stern stem control points are pulled aft to create recurve. 

• Cockpit shaping is sluggish. 
• Dragging a group of selected control points is sluggish.   
• There is no export of table of offsets. 
• Cockpit shapes are saved as part of the design file.  They cannot be saved to a separate 

file. 
• The inset curve on the printed stem forms (that accounts for strip thickness) is a bit of a 

cheat.  Since strips will cross the edge of the stem forms at an angle other than 90°, the 
curve should be inset a distance greater than the strip thickness and vary over the stem 
edge.  Instead, the inset is drawn the same as for the station forms.  Stem forms must be 
tweaked by hand if you want to account for this discrepancy. 

• The algorithm used to calculate the inset curve gets unstable at areas of sharp curvature.  
On the printed stem form curves, the inset curve can look a little weird at the tips of the 
bow and stern.  

September 24, 2002 1.0 Beta 1 • Better approximation of the buttock curves as they cross the sheerline. 
• Placed limits of travel for certain control points (hull control points between entry and exit 

must be underwater, cockpit height must be above water). 
• About-box with acknowledgements. 
• Since cockpit shapes can be modified, it didn’t make sense to name them “small”, 

“medium”, “large”.  The shapes have been changed to “A”, “B”, “C”. 
• Fixed: Change of filename did not update window caption or Windows menu contents. 
• Fixed: With multiple designs active, selecting one from the Windows menu did not switch 

focus to that design. 
• Fixed: Changing the sheerline curve in the Profile view did not cause the waterline curves 

to be recalculated.  
• Fixed: Dragging the control point at the tip of the stern stem towards the bow causes a 

resize which can make other stern control points inaccessible. 
• Fixed: Closing the main application window exited immediately instead of performing an 

orderly close of active windows. 

Known Bugs and Limitations: 

• Recurve at the stern is not handled very well.  The program calculates LOA based on the 
distance between control points at the tip of the bow and stern.  This will be inaccurate if 
the stern stem control points are pulled aft to create recurve. 

• Cockpit shaping is sluggish. 
• Dragging a group of selected control points is sluggish.   
• The study drawing printing is incomplete. 
• There is no export of table of offsets. 



• Cockpit shapes are saved as part of the design file.  They cannot be saved to a separate 
file. 

• The same design file can be opened multiple times within the same session. 
• The inset curve on the printed stem forms (that accounts for strip thickness) is a bit of a 

cheat.  Since strips will cross the edge of the stem forms at an angle other than 90°, the 
curve should be inset a distance greater than the strip thickness and vary over the stem 
edge.  Instead, the inset is drawn the same as for the station forms.  Stem forms must be 
tweaked by hand if you want to account for this discrepancy. 

• The algorithm used to calculate the inset curve gets imprecise as the distance increases 
between points in the model curve.  On the printed stem form curves, the inset curve can 
look a little weird at the tips of the bow and stern.  

• Currently, there’s no tool to help judge a curve’s fairness. This could be done by displaying 
an exaggerated curve or by displaying a 2nd derivative curve (indicating abrupt changes in 
slope). 



September 12, 2002 1.0 Alpha 7 • Added Edit/Scale dialog to support design scaling.  Length, width, and height may be 
scaled independently. 

• Added Zoom in/out for each graphical display panel.  The right-click popup has an entry to 
control the zoom level.  Also, the +/- keys increment/decrement to the next zoom level.  
The zoom level ranges from 100% to 300% in 25% increments.  The scroll bars appear for 
all zoom levels except 100%.  The display area can be scroll by keyboard as well using 
SHIFT-<arrow keys>. 

• Added new dialog for form printing (station forms, bow & stern stem forms, and cockpit 
templates).  Allows user to specify starting station form location, form spacing, minimum 
length of bow and stern stem forms, and strip thickness to be used in construction.  
Checkboxes for each form controls which forms are printed.  The active section can be 
moved and printed independently for printing bulkheads forms.  The Calibrate Printer 
operation allows the user to determine the accuracy of the printer metrics supplied by the 
printer driver.  The user may specify X and Y axis scaling factors to correct for any 
discrepancies.  The scaling factors may also be used to reduce the scale of the design for 
constructing models (Note: strip thickness will be scaled as well). 

• Cursor shape changes when hovered over a control item. 
• Added optional graphical display of entry/exit half-angle in the Plan view.  The right-click 

popup menu contains an entry to toggle this feature.  The filled pie slice indicates both the 
angle and the distance from the endpoint where the angle is computed.  This measurement 
distance for Entry and Exit half-angles can be modified by entries in the hydrostatics data 
panel (the distance is 1 meter by default). 

• Added “What’s This” support to the various panels.  Shift-F1 or the toolbar button activates 
this function.  Click the modified cursor over any of the panels to get a brief panel 
description. 

• Added a Baseline display to the Profile and Body Plan panels.  The right-click popup menu 
contains an entry to toggle this feature. 

• Added Debug Logging to Options menu.  By default, logging is disabled.  When enabled, 
the program will write all debugging information to the file “debug.out”. 

• Added more rigorous checking during processing of data files. 
• Renamed executable to “kfoundry.exe”. 
• The Plan view now uses one set of cockpit control points per shape.  In alpha5, there were 

race conditions that could cause oscillations when resizing one of multiple cockpits with the 
same shape.  Those oscillations would hang the system. 

• The cockpit in the Plan view is now drawn with a thicker line (to represent the cockpit rim). 
• Added computed cockpit width to displayed data. 
• Adding/Removing a cockpit is now an undoable operation. 
• The sheerline is now always displayed in the Profile view. 
• The Opaque/Transparent modes of the right-click popup menus have been collapsed into 

single checkable menu items.  In the Plan view, there is a Waterlines menu item.  In the 
Profile view, there is a Buttocks menu item.  In the Body view, there is a Solid Forms menu 
item. 

• Changed some of the color scheme, added background patterns, and added gradients to 
the water, waterlines, and buttocks.  The additional visual details have some performance 
costs.  The amount of detail is user-controllable with a new Detail Level menu item in the 
Options menu.  With the exception of color changes, the lowest setting mimics the previous 
releases.  The middle setting adds the gradients.  The highest setting adds sky background 
patterns.  

• Moved the Bow Orientation setting to the Options menu. 
• Optimized the computation of some curves, which may result in some performance benefit. 
• Added “Hide” to the right-click popup menu of each panel. 
• Changed file extension from “xml” to “yak”.  When saving a file, if the specified filename 

does not have an extension, “.yak” is appended to the name. 
• Fixed: Program could hang when cockpit shape was being changed. 
• Fixed: Cockpit height control points in Profile view could be displayed incorrectly when 

restored from saved file. 
• Fixed: The representative section positioning controls in the Active Section panel could 

stop working when the overall length of the kayak was modified. 
• Fixed misspelled “cockpit” in edit menu entries. 
• Fixed: Length text edit fields interpreted unitless numbers as feet.  Units must be specified 

for length measurements. 
• Fixed File/Close (Ctrl-W) to close active design instead of closing the entire application. 
• Fixed: Embedded all program graphics (icons). 
• Fixed: Corrected window sizing problem when opening the second and subsequent 

existing data files. 
• Fixed: Added missing columns to clipboard string for Matt Broze’s drag spreadsheet. 

July 9, 2002 1.0 Alpha 6 • Rudimentary printing of study drawings.  Currently, this prints plan, profile, and cross-
sections on a single page (but, no dimension or stats). 

• Added some new hydrostatic data items: half-angle of entry and exit, wetted surface area, 
Maximum Section Coefficient (Cx), Block Coefficient (Cb), cockpit heights. 

• Added settings for cargo weight and estimated finished boat weight (which contribute to 
overall displacement). 

• Added new Edit menu item to copy appropriate input values to clipboard for entry into the 
Matt Broze drag prediction spreadsheet.  The format follows that generated by Bearboat. 

• Added a rubber-band feature to select multiple control points (mouse click and drag). 
• Multi-cockpit support (1, 2, or 3 cockpits) with independent shape definition.  The edit menu 

now contains items to add/remove cockpit.  The data panel is updated to reflect the 
number of cockpits.  Each cockpit has settings for shape, paddler weight, and aft-edge-to-
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CG.  The 2nd and 3rd cockpits have a setting for spacing that controls the distance between 
its aft edge and the aft edge of the cockpit directly in front of it.  Each cockpit can have 
different shape or share a shape with another cockpit (Note: current cockpit names are 
Small, Medium, and Large.  The naming is somewhat inappropriate since the shapes can 
be resized.  I need to change the naming to something that makes more sense.) 

• Added cockpit rim in Profile view. 
• Moved the midship marker above the deck in the Profile view (instead of at the waterline) 

to reduce clutter. 
• Used consistent text color for locations and dimensions shown in the various view panels. 
• Re-organized data panel into functional groups (rather than view-specific groups).  The 

mutable parameters have been disbursed to the appropriate functional group (still color-
coded blue to distinguish them from the other entries). 

• Slightly more responsive drag of multiple control points. 
• The total displacement is now computed from the cumulative paddler weight(s), cargo 

weight, and estimated boat weight. 
• Fixed: Added the missing curve at the deck ends when there is a specified bow or stern 

deck offset. 

Known Bugs and Limitations: 

• The controls that move the active section to the next/previous shaping position can stop 
working when the overall length is changed. 

• There is some lag-time between the dragging the cockpit shape controls and the shape 
being redrawn. 

• Dragging a group of selected control points is not smooth.  This is because curve 
calculations begin before all of the points have been repositioned.   

• No preferences dialog for colors, fonts, etc. 
• No useful printing 
• File/Close and File/Quit have same effect – Quit. 
• Some graphics not shipped with the program show-up as empty white squares in certain 

title bars. 
• Control points can be dragged to unnatural locations that result in a shape that does not 

resemble a kayak.  Need to consider placing limits on control point travel. 
• In the File/Save and File/Open, entering a filename without a file extension does not 

automatically append the default extension (currently “xml”). 



April 17, 2002 1.0 Alpha 5 • Added midship symbol in Plan and Profile views. 
• Changed graphic for sliding active section handle. 
• Added new Active Section View.  This panel displays the full active section and its 

dimensions.   
• The Active Section View is used for hull and deck cross-section shaping.  The shape of a 

number of “representative sections” influences the overall kayak cross-sectional shape.   At 
present, these sections are fixed at locations that are 10%, 30%, 50%, 70%, and 90% of 
the overall length.  Each representative section provides a set of deck and hull shaping 
control points that define the shape for that section.  The remaining kayak sections are 
automatically blended from the representative sections.  Arrow buttons move the active 
section to the next/previous representative section.  The spacebar moves the active 
section to the next higher section.  The shaping control points in the Active Section are 
visible only for the representative sections. 

• The right-click popup menus in the Plan and Profile view now contain menu items to 
show/hide the hull control points.  When enabled, the line that is displayed shows the 
placement of the control points that are used in the cross-sectional blending.  The small 
circles are for visual feedback only in the Plan and Profile views – all hull cross section 
shaping must occur in the Active Section view. 

• The Plan view right-click popup menu contains an entry to show/hide the cockpit controls.  
Once the cockpit has been shaped, you can hide the control points to reduce clutter and to 
prevent accidental changes to the shape. 

• Fixed: Entering length parameters without units now reverts back to original value. 
• Fixed: Extended the allowable range from aft edge of cockpit to CG.  The overly restricted 

range would have prevented large, multi-person cockpits. 

Known Bugs and Limitations: 

• Dragging a group of selected control points is not smooth.  This is because curve 
calculations begin before all of the points have been repositioned.   

• No preferences dialog for colors, fonts, etc. 
• No useful printing 
• File/Close and File/Quit have same effect – Quit. 
• Some graphics not shipped with the program show-up as empty white squares in certain 

title bars. 
• Control points can be dragged to unnatural locations which results in a shape that does not 

resemble a kayak.  Need to place limits on control point travel. 
• In the File/Save and File/Open, entering a filename without a file extension does not 

automatically append the default extension (currently “xml”). 
April 5, 2002 1.0 Alpha 4 • Superimposed a mini cross-section on the sliding active-section control line.  This allows 

you to see the shape without having to move your eyes down to the Body plan view (which 
had to be in transparent mode in order to provide a good visual of the active section). 

• Implemented a single-cockpit deck.  The default File/New kayak now has a sizeable 
cockpit.  It is shaped by a set of control points in the Plan view.  The cockpit is auto-
positioned based on the location of the CB.  The aft edge of the cockpit is used for this 
reference – the distance between the aft edge and CG of the paddler can be set in the 
hydrostatic data panel.  The control point at the front of the cockpit can be moved to make 
the cockpit larger or smaller.  The curvature control point positions are constrained to 
ensure that the cockpit curve is smooth at the centerline.  Cockpit height can be adjusted In 
the Profile view.  In Profile, the cockpit size is locked to avoid accidental changes to its 
shape.   

• Fixed: size problem when opening more than one kayak window.  Now, opening a 2nd and 
subsequent kayak sizes the new window to match the size of the most recently active 
window. 

Known Bugs and Limitations: 

• Dragging a group of selected control points is not smooth.  This is because curve 
calculations begin before all of the points have been repositioned.   

• No preferences dialog for colors, fonts, etc. 
• No useful printing 
• File/Close and File/Quit have same effect – Quit. 
• Some graphics not shipped with the program show-up as empty white squares in certain 

title bars. 
• Control points can be dragged to unnatural locations which results in a shape that does not 

resemble a kayak.  Need to place limits on control point travel. 
March 25, 2002 1.0 Alpha 3 • Re-factored the data stored in the kayak data file.  The data-driven nature of the program 

made it too susceptible to user “fiddling” in the xml data.  Now, the data definitions are 
hard-coded within the program and the kayak data file must track the internal definition. 

• Preference data has been extracted from kayak data file and moved to a xml file.  The 
Preference format is also governed by an internal definition.  Preferences will contain all 
display preferences (color information), and new boat preferences (bow/stern deck offsets, 
etc).  Note: preferences have not been moved to a preferences file yet.  They have been 
separated from the kayak data, but they are still hard-coded internal data. 

• The user-specified waterline has been removed.   Each cross-section hull shape is created 
with a single curve from the sheerline to the keel, and the program derives the waterline 
from this.  This allows the user to achieve a desired hull cross-section with much greater 
ease than before.  The waterline is still displayed in the Plan view, but it is now a 
synthesized curve, rather than a user-specified design constraint.  



• For cross-sections where the specified underwater area is greater than the area of the 
generated curve, the section is drawn in red.  This is an indication that the program could 
not achieve a reasonable shape that would satisfy all constraints. 

• Near the ends of the kayak where the underwater curve of the cross section is less than 
250 mm2 (including those sections that are completely out of the water), the shape of the 
cross-section is interpolated from the last fully-computed cross section.  This ensures that 
the section shapes flow together smoothly all the way to the ends of the kayak.  

• New user control for hull cross-section shaping (for the curve from sheer to keel).  The 
temporary slider has been removed.  The user now influences the placement of the Bezier 
control points for the cross-sectional curves by shaping a control line superimposed on 
both the plan view and the profile view.  The control lines are color coded to match the 
corresponding control point indictors that are displayed with the active section in the Body 
plan view.  The hull-shaping control lines in the Plan and Profile are not enabled by default 
(to eliminate clutter).  Those lines can be activated by using the right-click popup menus in 
each of those views.  

• Bow-right and bow-left display.  The View menu has a item to toggle between the two 
display modes. 

• Body plan displays centerline only for split bow/stern view. 
• Modifications to editable entry fields are now aptured by the undo/redo system. 
• Hydrostatic data elements are now redrawn individually rather than repainting the entire 

list.  This prevents the strange behavior of the data scrolling to keep the selected element 
is visible. 

• Limited bow/stern deck offset to the range 0 to 25mm 
• Limited Displacement to the range 100 to 800 lbs. 
• Changed “English” to “Imperial” 
• Swapped the locations of the Body plan and Curve of Areas panels.  This places the cross-

sections next to the hydrostatics data, so the display of the active section and its 
corresponding data are side-by-side. 

• Changed printing (which currently is only a split bow/stern view) to perform clipping so that 
the result is similar to the Body plan view in Opaque mode.  

• Fixed: Sliding active-section line was not redrawn properly after being obscured by a 
dialog. 

• Fixed: Divide by zero when control points moved to unnatural locations. 
• Fixed: Control points could be dragged off screen.  
• Fixed: Moving the arrow keys was recording undo information even when no control points 

were selected. 
• Fixed: Setting focus into a panel with selected control point(s) with a mouse click and drag 

caused the control point(s) to immediately move to the mouse position.  Those control 
point(s) should not move until “picked-up” again with the mouse or nudged with arrow keys.  

• Fixed: Bow/Stern label in Body plan view didn’t change to reflect the display mode (bow-
only, stern-only, bow/stern). 

Known Bugs and Limitations: 

• Dragging a group of selected control points is not smooth.  This is because curve 
calculations begin before all of the points have been repositioned.   

• No preferences dialog for colors, fonts, etc. 
• No useful printing 
• File/Close and File/Quit have same effect – Quit. 
• Some graphics not shipped with the program show-up as empty white squares in certain 

title bars. 
• Control points can be dragged to unnatural locations that result in a shape that does not 

resemble a kayak.  Need to place limits on control point travel. 



March 14, 2002 1.0 Alpha 2 • Added English/metric display.  Click on the Value column of Hydrostatics to toggle between 
English and metric units.  The location indicators in each of the panels change as well. 

• Added toolbar with common tool buttons (button icons subject to change.) 
• Added rudimentary “About” box. 
• Started implementing the “What’s This?” functionality 
• Added “Save As” function 
• Added “View All” menu item to the View menu.  This menu item is grayed-out when all 

views are visible, and becomes enabled when at least one view has been hidden. 
• Implemented editable fields in the hydrostatics list view.  Currently, all editable fields are 

grouped under Parameters.  There are fields for displacement, bow deck offset, and stern 
deck offset.  Double-click on the field to open the edit field.  Click out of the edit field or hit 
return to modify value.  Escape reverts to original value.  Weight fields understand units of 
“kg” and “lb” (and variations).  Weight fields without units will use the currently displayed 
unit.  Distance fields understand units of “mm”, “cm”,  “in” (and variations).  Distance fields 
don’t have a default units, so you must enter a unit designator.  I’ll add more unit 
designators later.  Editable fields are currently indicated by colored text.  I may add an icon 
instead or in addition to make it more obvious that they’re editable.  (Right now, there are 
no constraints on the values, so you could, for example, enter 40” for bow-deck-offset.  Go 
ahead, try it, I dare you.  I intend to constrain all entry fields to reasonable min/max values 
where that makes sense)  

• Removed the header bar in each panel for displaying “Bow” and “Stern”.  Replaced with 
floating text within the panel itself.  (Increased drawing space) 

• Removed centerline drawn down center of Plan view in Opaque mode.  I felt that it was 
detracting from the view of the waterlines.  (Let me know if you think it was useful to see – I 
can add an option to display it) 

• Added more data items to the Hydrostatic panel 
• Embedded the parameters for the default kayak within the program.  The program no 

longer uses the defaultKayak.xml file.  
• Added arrow control point to sliding “active section” line.   Click and drag the arrow to 

position the line. The arrow graphic will probably change; I just grabbed something.  Using 
a control point to move the line is more consistent with the rest of the interface. 

Known Bugs and Limitations: 

• Changes to the position of the hull-shaping slider and the editable entry fields are not 
captured by the undo/redo mechanism. 

• Dragging a group of selected control points is not smooth.  This is because curve 
calculations begin before all of the points have been repositioned.   

• No preferences dialog for colors, fonts, etc. 
• No useful printing 
• File/Close and File/Quit have same effect – Quit. 
• Some graphics not shipped with the program show-up as empty white squares in certain 

title bars. 
March 8, 2002 1.0 Alpha 1 • It had what it had 
�


